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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

 Version number, which indicates the software version.  

 Publish date, which changes each time the document is updated.  

Important Note: The initial version of this document is included in the patch package that is shipped with 

the patch release.  However, this document may undergo modifications after the patch is released.  To check 

for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 

Contact your HP sales representative for details. 

Note: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 

download Adobe Acrobat Reader, go to the following web site:  

http://www.adobe.com/ 

http://h20230.www2.hp.com/selfsolve/manuals
http://h20229.www2.hp.com/passport-registration.html
http://www.adobe.com/
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Enhancements 

The following information supports updates included in this patch. 

 Changes to the Web Tier Directory Structure 

 The New Mask and Time Out parameters 

 New Parameters 

 Warnings for Duplicated Entries in smi.ini or in the Command Prompt 

 Case Insensitive LDAP Login 

 Login Times Reported in sm.log File 

 How Relationship Models are used with Change and Request Types 

Changes to the Web Tier Directory Structure 

QCCR1E69692 introduces significant changes to the directory structure of the Service Manager (SM) Web 

tier. Specifically, the directory structure of the Web tier has been modified to reflect the current build 

number of the Web tier.  These changes were implemented because the SM Web tier is typically updated 

every few months.  When these updates occur, it is sometimes necessary for users to clear their browser 

cache.  For enterprise clients that have tens of thousands of users, getting all of those users to do this 

requirement is onerous.   With this revised implementation, users will no longer need to clear their browser 

cache if they do not use the MySM module. Detailed information on the specifics of these directory changes 

can be found in the “Updates to the Service Manager Web Tier Directory Structure” white paper at 

the HP Software support Web site: 

www.hp.com/go/hpsoftwaresupport 

The New Mask and Timeout Parameters 

There are occasions where browser performance when using the Service Manager Web client can appear 

sub-optimal.  With the current Web-tier, there is a “mask” mechanism that masks the user’s web page before 

a server side response is received.  This behavior prevents the user from doing anything further which may 

issue a new request.  This mask appears as a grayed out window overlaying the browser.   However, this 

mechanism may make it appear as if the browser has hung or frozen, or otherwise performing poorly.  

To help manage browser performance and apparent hang or freeze issues when using the Service Manager 

(SM) Web client, the autoCloseMaskDelay, unmaskDeferMillis, socketReadTimeout, lockWaitTimeout 

parameters were created to facilitate control over the mask behavior.  Brief descriptions of these parameters 

can be found in the New parameters section.  

Important:  Incorrect configuration or use of these parameters can severely impact both real and apparent 

performance!  Detailed information on the specifics of these parameters can be found in the web.xml 

configuration file and in the “Using the Mask and Timeout Parameters in HP Service Manager” 

white paper at the HP Software support Web site: 

www.hp.com/go/hpsoftwaresupport 

New Parameters 

This patch introduces the following new parameters: 

http://www.hp.com/go/hpsoftwaresupport
http://www.hp.com/go/hpsoftwaresupport
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 autoCloseMaskDelay 

 unmaskDeferMillis 

 socketReadTimeout 

 lockWaitTimeout 

 loginWaitTime 

 maxrecordsetspersession 

 enableAnubisMonitor 

 anubisPollInterval 

autoCloseMaskDelay 

Description  

Specify the delay (in seconds) before which the mask is automatically closed. This parameter value must be 

>= 60 seconds. Uses default value 180 seconds if any invalid value is specified.  

Location:  

web.xml 

Requires restart of Web application server?  

Yes 

Default value:  

180 seconds 

Possible values: 

60-300 seconds 

Example usage: 

  <context-param> 

    <param-name>autoCloseMaskDelay</param-name> 

    <param-value>180</param-value> 

  </context-param> 

unmaskDeferMillis 

Description  

Defer the unmasking of a browser window after an unmask request is issued. This parameter relates to how 

much time (in milliseconds) the client browser needs to finish rendering after a page is loaded. The client 

user may feel low application performance if set it to a value greater than 2000. 

Location:  

web.xml 

Requires restart of Web application server?  

Yes 

Default value:  

750 milliseconds 

Possible values: 

 350-3000 milliseconds 

Example usage: 

<context-param> 
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    <param-name>unmaskDeferMillis</param-name> 

    <param-value>750</param-value> 

  </context-param> 

showMaskCloseButtonDelay (deprecated) 

The showMaskCloseButtonDelay was introduced in previous hotfixes only, but was deprecated before this 

patch release. 

The following two parameters were created to assist in managing how long a client request should wait 

before timing out: 

socketReadTimeout 

Description  

The socketReadTimeout parameter prevents a thread on the Web tier application server from waiting 

infinitely for a socket IO operation.   After the specified time (in seconds) is reached, the socket read 

operation will terminate.   

Location:  

web.xml 

Requires restart of Web application server?  

Yes 

Default value:  

180 seconds 

Possible values:  

Any value is valid.  A value of less than or equal to 0 will indicate no time out limit. 

Example usage:  

    <init-param> 

      <param-name>socketReadTimeout</param-name> 

      <param-value>180</param-value> 

    </init-param> 

lockWaitTimeout 

Description  

The lockWaitTimeout parameter prevents a Web tier application server thread from waiting infinitely to 

acquire a lock.  After the specified time (in seconds) is reached, a thread will cease trying to acquire a lock, 

and the user will see the following warning message appear:  

“The session is busy, please try again later.” 

Location:  

web.xml 

Requires restart of Web application server?  

Yes 

Default value:  

15 seconds 

Possible values:  

1-300 seconds (A value of less than or equal to 0 will indicate the maximum value 300 is used) 
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Example usage: 

    <init-param> 

      <param-name>lockWaitTimeout</param-name> 

      <param-value>15</param-value> 

    </init-param> 

loginWaitTime 

Description  

Defines the maximum idle time (in seconds) allowed for the login page. If the user stays on the login page 

longer than the time specified, a logout page will be returned when the user clicks the login button.  

Location:  

sm.ini 

Requires restart of Service Manager server?  

Yes 

Default value:  

180 seconds 

Possible values: 

Positive integer; If an invalid value (negative, zero, or non-numeric value) is specified, the default 

will be used. 

Example usage: 

  <context-param> 

    <param-name>loginWaitTime</param-name> 

    <param-value>180</param-value> 

  </context-param> 

maxrecordsetspersession 

This parameter specifies the maximum allowed number of recordsets that a client session can keep active. 

This limit helps prevent the server from running out of memory.  

Note: A zero value (default) disables the feature, which means there is no limit on the number of recordsets 

that can be opened in a client session; the minimum is 400 recordsets. 

Example usage 

Command line: sm -httpPort:13080 -maxrecordsetspersession:800 

Initialization file (sm.ini): maxrecordsetspersession:800 

See QCCRIE66688. 

Location:  

sm.ini  

Server’s OS command prompt 

Requires restart of Service Manager server?  

Yes 

Default value:  

0: Disables this feature (no limit). 

Possible values:  
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0: No limit; 

A value no less than 400 (recordsets) 

Example usage 

Command line: sm -httpPort:13080 -maxrecordsetspersession:800 

Initialization file (sm.ini): maxrecordsetspersession:800 

enableAnubisMonitor 

Description 

Start the Anubis monitor to check the status of the background scheduler thread. This parameter starts the 

Anubis monitor to check the status of the background scheduler thread.   

Location:  

sm.ini  

Server’s OS command prompt 

Default value:  

1 (Enabled) 

Possible values:  

0 (Disabled)  

1 (Enabled) 

Note: When enableAnubisMonitor is enabled, the original Anubis RAD applications (apm.anubis and 

apm.anubis.restart) should be disabled.  

anubisPollInterval 

Description 

 The time interval (in seconds) at which the Anubis thread checks to see if any registered scheduler is alive. 

Default is 15 (seconds).  

Location:  

sm.ini  

Server’s OS command prompt 

Default value:  

15 (seconds) 

Possible values:  

Any time interval (in seconds) 

Warnings for Duplicated Entries in sm.ini or the Command Prompt 

A warning message is logged in the sm.log file when one parameter is specified more than once in sm.ini or 

has multiple inputs in the server’s operating system command prompt. See QCCRIE72988. 

Case-Insensitive LDAP Login 

When LDAP is used, user login is now case-insensitive. Upper-case (FALCON), lower-case (falcon), or camel 

case (fAlcOn) can all be used. See QCCRIE70459. 
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LDAP will now always be the primary data source of the operator table. The following describes the new 

case-insensitive login behavior with LDAP and a case-insensitive DB: 

1 (User “admin” exists in the AD server.) Log in with either “admin” or “ADmin”.  

Result: Login is successful, and user “admin” is automatically added to the operator table. 

2 Add user “john.smith” in the AD server, with a Display Name (CN) of “john.smith”. Log in as 

john.SMITH.  

Result: Login is successful, and user “john.smith” is automatically added to the operator table. 

3 Disable LDAP in sm.ini first (or the LDAP user will be deleted  too), and then do the following: 

a Manually delete “john.smith” from the operator table. 

b Manually add john.SMIth to the operator table. 

c Enable LDAP in sm.ini. 

d Log in as John.Smith. 

Result: Login is successful, and John.Smith is NOT automatically added to the operator table. 

Login Times Reported in the sm.log File 

A new message is now available from the sm.log file that indicates how much time (in seconds) a user login 

takes. See QCCRIE72686.  

It mainly covers the time consumed by the login RAD application. If the RAD name is "login" and label is 

"cleanup", the log message will look like the following, where 3.921 (seconds) is the login time:  

How Relationship Models Are Used With Change and Request Types 

The "Service Manager record relationship models" topic should be updated to the following: 

 

Service Manager Service Desk relationship models are methods to control the relationships between records 

inside Service Manager. The Service Desk relationship models affect four record types: Service Desk 

interaction records, Incident Management incident tickets, Change Management change requests, and 

Request Management quote orders. A Service Desk Agent can: 

 Open an incident, complaint, or request for information in Incident Management. 

 Open a request for change in Change Management. 

 Open a Request Management quote to order a product or service. For example, if a user complains 

that a printer has stopped working and the Service Desk Agent determines that an older printer is 

not compatible with a new laptop, the agent can open a Request Management quote to order a new 

printer for the user. Once the order is placed, the Service Desk Agent can close the interaction record 

and add the quote order number for the new printer to the resolution note of the interaction. The 

quote order is also associated to the interaction record, so that even though the interaction is at a 

closed status the agent can refer back to the closed interaction to check the status of the related 

quote order. 

The following can be set in the Service Desk Environment Profile record and are models for managing 

Service Desk record relationships: 
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 Full Service Desk Model: In this model, the state of a Service Desk interaction record changes when 

each related record closes. The closed state of an interaction record depends on the notification value 

chosen for the "Notify By" field in the interaction record.  For example, if the notification value is 

"Telephone," the interaction record has a required action before it is closed.  This action describes 

why the customer must be contacted.  It also prevents the interaction record from closing until all 

required actions are complete. In this case, the interaction record goes into the Open-Callback state 

before it is closed. For more information, see Full Service Desk model. 

 All Records close Independently: In this model, all Service Desk interaction records close 

independently. The state of related records does not affect closing an interaction record, and closing 

the interaction record does not affect related records. 

 Close Interactions when Related Record closes: In this model, when the last related record closes, the 

Service Desk interaction record closes. 

 Cannot close Related Record until Interactions are closed: In this model, records related to a Service 

Desk interaction cannot close until the interaction record is closed. 

 Cannot close Interactions until Related Records are closed: In this model, a Service Desk interaction 

record cannot close until all related Incident Management tickets, Change Management requests, 

and Request Management quotes are closed. 

Note: The updated document will be available in the online help of the next release of Service Manager. 

Additional Enhancements 

The following enhancements are included in the current software release. 

Global ID Module Problem  Solution  

QCCR1E70811 Server Need to enhance the 

login idle status control 

for the web client. 

 

Introduced a new parameter "-

loginWaitTime:n", which defines the 

maximum idle time (in seconds) allowed for 

the login page. If the user stays on the login 

page longer than the time specified, a logout 

page will be returned when the user clicks 

the login button. 

The default value of this parameter is 180 

seconds (3 minutes). If an invalid value 

(negative, zero, or non-numeric value) is 

specified, the default will be used. 

To set a value other than the default, specify 

loginWaitTime:n in sm.ini or in the server's 

operating system command prompt, and 

then restart the server. 

 

Note: This parameter is functional in the SM 

9.21.p5 (and later versions) server only when 

used together with an SM 7.11 client.  

Otherwise, it is ignored. 
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Fixes 

Service Manager Version 9.21, build 290 patch 5 (SM 9.21p5) includes several customer requested software 

fixes. Refer to the sections below for information about the defects for each release included in this 

cumulative patch. 

Service Manager 9.21 patch 5 updates the following areas: 

 Application updates 

 Documentation changes 

 Server updates 

 Web client updates 

 Windows client updates 

Applications Updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E67647 There is a need for extra information 

in the exception message that occurs 

in the request response when closing 

an interaction by calling 

CloseInteraction from a Web service 

without specifying the localSolution 

field in the request. 

Updated the following scmessage record 

from "Doc Engine call failed with cc %d" to 

"Doc Engine call failed with cc %d msg: %s": 

- Message Number: 19 

- Class: scxmlapi 

QCCR1E70163 The KMUpdate process terminates 

abnormally even though it is not 

terminated manually. Additionally, 

the KMUpdate process may terminate 

even if no internal errors occur. 

When the Search Engine server is shut 

down or an indexing document error occurs, 

the KMUpdate process will not terminate, 

and error messages will be written to sm.log 

to indicate the exception details. 

Documentation Changes  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E49518 No documentation is available about 

how relationship models are used with 

Change and Request types. 

See the “How relationship models are used 

with Change and Request types” section 

following this table. 
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Global ID Problem Solution 

QCCR1E66827 A NullPointerException is reported in 

the WebSphere 7.0 logs (System.out), 

when the local class loader is set to 

parent first and the class loader order 

is set to parent last. 

HP recommends using the following 

deployment procedure: 

1. Deploy the .ear file of the Service 

Manager web tier on WebSphere 7.0. 

Note: The .ear file contains the .war file. 

2. Configure the Service Manager web 

application as follows: 

a. Go to Enterprise Applications > HP 

Service Manager *** Web > Class loader, 

and select the following settings: 

Class loader order: Classes loaded with 

local class loader first (parent last) 

WAR class loader policy: Single class 

loader for application 

b. Go to Enterprise Applications > HP 

Service Manager *** Web > Manage 

Modules > webtier-***.war, and select the 

following setting: 

Class loader order: Classes loaded with 

parent class loader first 

QCCR1E67991 The Service Manager 

SM9.21_p2_Release_Notes.pdf does not 

mention what to do with the file 

QCCR1E31545_SM921P2_SM920.unl, 

which appears in the platform_unloads 

directory for the patch. 

Updated the release notes and published 

on the SSO Manuals Site. 

QCCR1E69449 The documentation needs to state that 

when modifying a dbdict record, users 

need to ensure there are no other users 

updating or inserting records in the 

same file. For example, when updating 

the probsummary dbdict record, users 

need to make sure there are no other 

users updating existing Incident 

records or opening new Incident 

records. 

The "Database dictionary (DBDICT) 

utility" section of the Tailoring Best 

Practices Guide of the next release of 

Service Manager will be updated. 

QCCR1E71067 The Service Manager 9.21 Patch 3 

Release Notes document could mislead 

customers running on Service Manager 

applications version 9.20 to load 

QCCR1E56678_SM921P3_SM711, 

which is only needed for applications 

version 7.11. 

Updated the Service Manager 9.21 Patch 3 

Release Notes document, which now 

includes additional information on the 

unload file naming convention and clearly 

indicates the unload files specific for each 

applications version (7.11 or 9.20). The 

updated document is now available from 

the HP software manuals 

site:http://support.openview.hp.com/selfsol

ve/document/KM1306465. 
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Global ID Problem Solution 

QCCR1E71557 Documentation is needed on how to use 

the new configure.jar file of the server. 

 

The Service Manager server configure.jar 

file has been updated to enable encryption 

of the Service Manager database login 

credentials (username/password). To 

encrypt the database login credentials of 

an installed Service Manager system, 

follow these steps: 

1. Extract the server package (.zip or 

.tar) in this patch, and copy the 

configure.jar file to your <SM 

server installation> directory. This 

will overwrite your old 

configure.jar file if you did not 

move it to somewhere else after 

your installation.  

2. Run the configure.bat file in the 

installed system, without loading 

demo data.  

After completing these steps, the database 

login credentials in the sm.ini file are 

encrypted strings instead of clear text. 

Note: You can still manually specify clear-

text database login credentials in the 

sm.ini file, however HP recommends that 

you encrypt the credentials as described 

above. 

Server updates  

The following items are fixed in the current software release. 
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 Global ID Problem Solution 

QCCR1E72686 There is no log message that indicates how 

much time the login process takes. 

There is now the following log message 

when a successful login occurs: "User 

XXX login elapse time: YYY.ZZZ  

seconds" 

QCCR1E72988 When a parameter is defined multiple times in 

the sm.ini file, there is no indication as to 

which parameter value is being honored. 

A warning message is issued in the 

sm.log file when a parameter is specified 

multiple times in the sm.ini file.  

Additionally, SM will report and log 

more detailed information in cases where 

there is more than one command input. 

QCCR1E31928 Web Service RetrieveIncidentListRequest has 

the potential to cause a Java Heap Space out-

of-memory error when retrieving a list of 

records. 

Updated the server code so that the 

following applies for the request 

response: 

- When there is neither a start attribute 

nor a count attribute, return all 

records/keys. 

- When there is a valid start value but no 

count attribute, return all records 

starting from the start attribute. 

- When there is a valid start attribute 

and valid count attribute, return the 

number of keys/records starting from the 

start attribute. 

- When there is a negative start 

attribute, return from the first record. 

- When there is a negative count 

attribute, return one record. 

- When the start attribute is bigger than 

the total number of records/keys, no 

record is returned. 

QCCR1E49322 When using the dbdict utility to rename the 

SQL name of a field, it fails if the current SQL 

name is a reserved word in the database. 

The column names in the generated 

statement are enclosed between double 

quotes, which allows the SQL name of a 

field to become a reserved word. 

QCCR1E51838 With Mandanten security enabled, the group 

views in the ToDo list display no records. 

The group views in the ToDo list display 

records correctly. 
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QCCR1E54192 When trying to close an interaction by calling 

CloseInteraction from a web service without 

specifying the localSolution field in the 

request, a CXmlApiException occurs with a 

DocEngine error. 

A normal response will now be returned 

instead of the SOAP Fault. In addition, 

all or part of the following messages will 

occur in the request response depending 

on which field values are missing in the 

request: 

Doc Engine call failed with cc -1 Msg: ;  

You must enter a Solution to close this 

interaction.  

You must enter a Closure Code to close 

this Interaction. 

 

Note: To take advantage of this server-

side change, users also need to apply an 

applications fix QCCRIE67647 (by 

loading the relevant unload file). 

QCCR1E57188 Signal 11 and Signal 6 occur when starting the 

server on Linux with background processes 

enabled. 

 

Cause: Starting the sm process with 

system.start postfixed failed on Linux. There 

was signal 6 in the sm.log. 

No more signal in the sm.log and the 

system starts successfully. 

QCCR1E57292 Resource lock cannot be released or even 

cannot be killed using the 'k' command due to 

a plugin termination failure, even though the 

operator has logged out and the session does 

not exist. 

Added an exception handler for the 

plugin termination procedure so that 

Service Manager can clean up 

successfully when the operator is logged 

out. 

QCCR1E57907 The dbcount on joinsvcDisplay(JOIN) counts 

all records instead of those in qbe. 

The dbcount on joinsvcDisplay(JOIN) 

now excludes records based on the query. 

QCCR1E58862 The usergrid functionality does not work 

correctly when Service Manager is using an 

Oracle database. When the user attempts to 

open a saved column view by loading a named 

grid, the correct user grid may not be loaded. 

The usergrid functionality now works 

correctly. 

QCCR1E59119 Servlet container processes crash when 

parsing a large query with more than 2500 

conditions. 

Servlet container processes do not crash. 
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QCCR1E59527 In environments deploying a case-sensitive 

RDBMS in combination with a case-insensitive 

LDAP server for authentication, it might be 

impossible for users to successfully log in to 

Service Manager (SM). 

 

After login, the System Navigator displayed an 

empty tree and the main screen was partially 

rendered, which resulted in an inability to use 

SM. 

If the LDAP is used for authentication, 

users can now successfully log in with a 

lowercase, uppercase, or mixed-case user 

name and use SM properly after login. 

 

Without LDAP authentication, the case-

sensitivity of login depends on the case-

sensitivity setting of the RDBMS. 

QCCR1E59746 Knowledge Management: KMImport is not 

updated to reflect the km-import jar. 

The scripts will no longer hard code the 

jar file name for the class path. Instead, 

the value of the class path will depend on 

all the jar file names in the lib directory. 

QCCR1E59764 Try logging in to the web client index.do or 

Windows client as an Employee Self Service 

(ESS) user. User will be rejected, which is 

correct, but the session will not be terminated 

on the server side. 

The session should terminate if ESS user is 

rejected for logging in on non-ESS pages. 

Now, the ESS user login is rejected and 

the session is released as expected. 

QCCR1E60613 User cannot log in to the Service Manager 

server and instead receives the message 

"SOAP Fault occurred: "Server is running low 

on memory try again." The Service Manager 

server service has to be restarted to 

temporarily resolve the problem. 

When JVM memory usage is higher than 

90%, the system garbage collection is 

automatically called. 

QCCR1E64064 Using the appthreadspersession:x parameter, 

only x-1 tabs can be opened, not x tabs. 

The appthreadspersession parameter 

now works correctly. 

QCCR1E65095 The "Does not Contain" comparison does not 

work for an ARRAY text field. 

The "Does not Contain" comparison will 

work correctly for an ARRAY text field. 

QCCR1E65453 When trying to change the database field 

encryption key using the "sm -changeencrkey" 

command, the command failed to complete and 

left the database corrupted. 

Users can now successfully change the 

database field encryption key using the 

"sm -changeencrkey" command. 

QCCR1E65597 System encounters errors after a change to the 

dbdict on one of the following tables: code, 

format, link, counters, ScriptLibrary, 

scmessage, dbdcit, or datadict 

System performs normally after a change 

to the dbdict on any of these tables: code, 

format, link, counters, ScriptLibrary, 

scmessage, dbdcit, or datadict 

QCCR1E66601 Formatting applied to Knowledge Documents 

was lost when the document was used as a 

solution for an interaction. 

When invoking Use Solution on a 

Knowledge Document in an interaction 

record, formatting will be properly 

applied to all HTML tags. 
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QCCR1E66688 When performing a Case Exchange of Incident 

tickets from SM 7.11 to SM 9.20 via Connect-It 

(CIT), once CIT establishes a session, the 

thread associated with the session gradually 

uses more memory until all SM processes fail 

and a java.lang.OutOfMemoryError occurs: 

unable to create new native thread. 

 

This issue is caused by a Connect-It connector 

defect. The Connect-It connector sends an 

incorrect soap action for close filehandle 

operations. As a result of the incorrect soap 

action, the RTE does not properly close the 

filehandle that was opened and results in 

memory accumulation over time. This triggers 

the -Memory messages in the log, and would 

eventually cause the out-of-memory errors of 

the type "unable to create new native thread." 

When the user session logs off, all open 

filehandles are then closed and accumulated 

memory is released. 

The 

maxrecordsetspersession parameter has 

been introduced to limit the number of 

recordsets that a client can keep active, 

to prevent the server from running out of 

memory. 

 

See the maxrecordsetspersession section 

of this document. 

QCCR1E66812 In Service Manager (SM), when the SM 

administrator kills the scauto for OVO client 

(which is not the listener but the scauto for ovo 

user) in the System Status monitor, a message 

occurs indicating that the session is 

terminated, however it is not killed actually. 

The user session still exists on the server and 

the socket connection is still established. 

The SM administrator can kill the 

SCAuto client user session successfully 

using the "k" command, which means the 

user thread will be terminated on the 

server and the socket connection will be 

forced to be disconnected by the server. 

QCCR1E67233 If the backend RDBMS is not started or the 

wrong ODBC driver is used when executing 

the command sm -sqlverifyconnection, the 

console freezes and connection 'retry' 

information prints infinitely in the server log 

file (sm.log). 

After trying the connection three times 

and failing to connect to the RDBMS, the 

failure information will print in the log 

and the connection command will 

terminate. 

QCCR1E67275 Number prefixes are not generated as 

expected. 

The number prefixes and suffixes are 

generated correctly even if there are no 

triggers on the number table. 

QCCR1E67946 Slow system performance occurred and 

reviewing the system status revealed that 

several background processes were idle for 

over three hours. 

Fixed the Service Manager load balancer 

so that load is now distributed evenly 

across all available servlet containers. 

QCCR1E67910 The fourth parameter of RAD function 

generate.sql.query() will not take effect when a 

boolean value is passed, whether it is true or 

false. 

The fourth parameter will be taken into 

account when a boolean value is passed. 
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QCCR1E68005 When a user connects through Trusted Sign-on 

(TSO) and exceeds the maximum number of 

concurrent logins, the server gives an error 

message. 

When the Service Manager client log-in 

fails, the correct message(s) will be 

displayed. 

QCCR1E68081 When trying to start Service Manager, users 

encounter a null pointer exception error:  

Exception in thread "main" 

java.lang.ExceptionInInitializerError 

Caused by: java.lang.NullPointerException 

at 

com.hp.ov.sm.common.auth.AutoPassClient.ge

tFeatures(AutoPassClient.java:48) 

at 

com.hp.ov.sm.common.resource.LicenseData.v

erifyLicense(LicenseData.java:114) 

at 

com.hp.ov.sm.common.resource.LicenseData.in

itData(LicenseData.java:213) 

at 

com.hp.ov.sm.common.resource.LicenseData.in

itializeAutoPass(LicenseData.java:66) 

at 

com.hp.ov.sm.common.core.Init.initializeLicen

se(Init.java:347) 

at 

com.hp.ov.sm.common.core.Init.getInstance(In

it.java:147) 

at com.hp.ov.sm.common.core.Init.getInstanc 

 

Error! initializing java in scjvm.cpp 

 

In addition, error messages similar to the 

following appear in the sm.log file: 

26219( 1) 08/11/2011 16:06:55 JRTE I Java 

version: 1.6.0_21 

26219( 19) 08/11/2011 16:06:55 JRTE I 

Starting Memory Monitoring thread to check 

for memory every 15 seconds. 

26219( 1) 08/11/2011 16:06:55 JRTE E 

Autopass Initialization Failed. Error Code: 

2013 Message: 2013 

26219( 1) 08/11/2011 16:06:55 RTE E Unable 

to Find Class com/hp/ov/sm/common/core/Init 

by ThreadId 1 

26219( 1) 08/11/2011 16:06:55 RTE D die: 

entered 

26219( 1) 08/11/2011 16:06:55 RTE E HP 

Service Manager is unable to start. 

When checking for existence of the 

license file, Service Manager no longer 

generates the null pointer exception and 

will report the correct error statements 

in the sm.log file. 
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QCCR1E68200 The displayed data List was incorrect after 

using Customize Current View when adding a 

field. 

 

Here is an example scenario: 

 

1. Log in to Service Manager as a system 

administrator. 

2. Select Interaction as Queue on the To Do 

Queue page. 

3. Select "All Open Interactions" as View.  

4. Click "Count Records". The number of 

records (for example, 198) is displayed. This is 

correct. 

5. From the More or More Actions menu, click 

"Customize Current View". 

6. Click Fields and then add "Contact Full 

Name" to the List. 

7. Click Finish. 

Only 4 records are displayed. After clicking 

field "Contact Full Name", only 2 records are 

displayed. This is incorrect. 

The displayed data List will be correct 

after the user adds a field to the list 

using the Customize Current View 

option. 

QCCR1E69154 Unable to see a localized values and display 

lists on dynamic forms. 

Service Manager now uses the global 

lists variable 'display.variable' to set 

display list values and the proper 

language will be displayed. 

QCCR1E69423 After the RTE binary patch P3HF4 and web 

client P3HF4 were applied, there were issues 

when users worked in the web client. The 

session often aborted unexpectedly with 

following error: "Logout successful". 

The "Logout successful" error no longer 

occurs. 

QCCR1E69448 Signal 11 encountered when a user is updating 

an incident record: RTE E Caught XML API 

exception scxmlapi(40). 

When one user is inserting data or 

updating data in a file (for example, 

probsummary) while another user is 

updating the dbdict record at the same 

time, Service Manager no longer 

generates a signal 11. 

QCCR1E69687 When the Search Engine server is not running 

or is disconnected from Service Manager, the 

KMUpdate process fails with a signal 6 in the 

sm.log and a core dump written to the disk. 

Introduced a new exception handling 

strategy to handle any error or exception 

from the Search Engine server. No 

matter whether the Search Engine is 

down or not, the KMUpdate process 

keeps running, unless the process is 

terminated manually. 
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QCCR1E70053 When using an unsupported SQL data type in 

a SQL mapping in Service Manager during a 

record insert, a corrupt error message is 

displayed. 

Now, when using an unsupported SQL 

data type in a SQL mapping in Service 

Manager during a record insert, the 

correct error message is displayed 

including the numeric representation of 

the unsupported data type. 

QCCR1E70184 After applying Patch 14 to Service Manager 

7.0.2, the number of database connections 

increases over time until no further 

connections remain. 

The resource leak, which was introduced 

by HTTP GET requests, has been fixed. 

QCCR1E70218 An unload file from a DB2 system cannot be 

loaded into an Oracle system. 

The unload files can now be loaded from 

DB2 with no problem. 

QCCR1E70349 Extra characters are inserted randomly in 

email messages sent by the scemail agent of 

Service Manager. 

A new JavaMail solutioin is used so that 

email messages are rendered correctly. 

QCCR1E70459 Service Manager (SM) versions 9.20 and later 

require that LDAP operators should match the 

case of the SM DB opeartors. However, this is 

not mandatory before SM9.20. After upgrading 

from SM version 7.10 to version 9.2x, some 

users may not be able to log in anymore with 

an error "Invalid username/password". 

This issue has been resolved. Now, login 

is case-insensitive, so end users can log 

in using "FALCON", "falcon", or 

"faLCon." Additionally, user ids do not 

have to match between LDAP and 

RDBMS anymore. 

QCCR1E70544 The Service Manager server experiences high 

CPU load and servlets stop responding to 

client requests. Over time, an administrator 

has to restart the service to recover from this 

condition. 

This high CPU load issue has been 

resolved. 

QCCR1E70915 When using the horizontal scaled parameters, 

an operator login name containing a comma is 

truncated in Service Manager System Status 

view. 

Operator login names containing commas 

are not truncated. 

QCCR1E70907 The _populateRecList() calls itself recursively 

until available memory is exhausted and a 

"Signal 11" error occurs. 

The memory leak is eliminated. 

QCCR1E70999 The field length automatically changes when 

adding new field into a Service Manager table 

with dbdict. 

When adding a new field, users are 

recommended to fill in all the necessary 

values, not only the SQL type 

varchar(50), but also other columns like 

SQL Name and SQL Table. If the user 

specifies a value for a column, Service 

Manager will now use the specified 

value; otherwise it will use a default 

value. 
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QCCR1E71027 A certain message in the eventout queue may 

cause the client to crash and prevent emails 

from being sent. 

Messages in the eventout queue should 

be processed correctly. 

QCCR1E71047 When you attempt to consume a third-party 

WSDL web service from ServiceCenter 6.2.8.8 

through an SSL channel, using Run WSDL to 

JS or a ScriptLibrary record, the connection 

aborts with the following error: 

 

22464(5750788) 11/23/2011 17:18:15 RTE E 

soap_sendRequest failed in step 0 with rc 22 - 

errnum 0 

22464(5750788) 11/23/2011 17:18:15 RAD E 

SOAP request failed - TCP error 22 - SSL 

authentication failed in tcp_connect(): check 

password, key file, and ca file. 

22464(5750788) 11/23/2011 17:18:15 RAD E 

Script <unknown script> line 0: ERROR 

uncaught exception: SOAP request failed - 

TCP error 22 - SSL authentication failed in 

tcp_connect(): check password, key file, and ca 

file. at char 1 

Service Center now can verify the 

certificate file and consume a WSDL web 

service. 

QCCR1E71341 If the directory path of JAVA_HOME contains 

a white space, executing wsdl2java.bat and 

runDocumentImport.bat will cause errors. 

When the directory path of JAVA_HOME 

contains white spaces, wsdl2java.bat and 

runDocumentImport.bat can run 

successfully. 

QCCR1E71657 User sessions hang or cannot connect after 

many different ESS users have logged in 

because the coordinator process runs out of 

memory. This behavior may occur even after 

the other users have logged out. 

The coordinator process will no longer 

run out of memory. 
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QCCR1E71698 When there are a large number of users logged 

on to a host, reportstatus -reporttolog locks the 

user chain and the following "Lock user chain" 

warning message is repeatedly logged in the 

sm.log file. This behavior may cause delays on 

connections or other operations. 

 

Example content of the log file: 

 

12324( 7660) 12/22/2011 09:55:39 RTE W 

WARNING: lock [6]User chain held for 344 

milliseconds by routine 

..\..\src\SCUserProcessChain.cpp line 412 

12324( 7660) 12/22/2011 09:58:40 RTE W 

WARNING: lock [6]User chain held for 360 

milliseconds by routine 

..\..\src\SCUserProcessChain.cpp line 412 

12324( 7660) 12/22/2011 09:59:40 RTE W 

WARNING: lock [6]User chain held for 282 

milliseconds by routine 

..\..\src\SCUserProcessChain.cpp line 412 

12324( 7660) 12/22/2011 10:00:40 RTE W 

WARNING: lock [6]User chain held for 343 

milliseconds by routine 

..\..\src\SCUserProcessChain.cpp line 412 

12324( 7660) 12/22/2011 10:01:41 RTE W 

WARNING: lock [6]User chain held for 282 

milliseconds by routine 

..\..\src\SCUserProcessChain.cpp line 412 

12324( 7660) 12/22/2011 10:03:41 RTE W 

WARNING: lock [6]User chain held for 265 

milliseconds by routine 

..\..\src\SCUserProcessChain.cpp line 412 

12324( 7660) 12/22/2011 10:05:42 RTE W 

WARNING: lock [6]User chain held for 265 

milliseconds by routine 

..\..\src\SCUserProcessChain.cpp line 412 

12324( 7660) 12/22/2011 10:06:42 RTE W 

WARNING: lock [6]User chain held for 360 

milliseconds by routine 

..\..\src\SCUserProcessChain.cpp line 412 

This behavior is prevented by copying 

the report to memory first, unlocking the 

user chain, and then printing the report 

to the log file. 

QCCR1E71786 Response times in the sm.log file (enabled by 

the "rtm:2" parameter) are incorrect for 

actions initiated from the navigator. 

Response times in the sm.log file 

(enabled by the "rtm:2" parameter) are 

correct for actions initiated from the 

navigator. 

QCCR1E71910 The ir.probsummary lock obtained by a user is 

never released. This causes many sessions to 

be waiting on this lock and may potentially 

lead to data integrity problem. 

The ir.probsummary lock will be released 

correctly. 
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QCCR1E72028 The RAD routine scheduler selects a set of 

records from the schedule file, and then 

processes only a single record before selecting 

the entire set again. This behavior is 

extremely inefficient. 

Root cause: The Anubis process is 

provided by RAD applications 

apm.anubis and apm.anubis.restart. It 

calls processes() to get all the running 

threads and processes, causing a high 

overhead. 

Resolution: The need for Anubis 

Process has been eliminated and the 

Service Manager background process has 

been modified such that it can manage 

and restart the registered schedulers in 

the case of exceptions:  

When a background scheduler starts, it 

will be registered to 

GenericThreadManager, except 

"system.start" and "scheduler.start". 

GenericThreadManager will check 

periodically whether the schedulers are 

alive. If a scheduler is not alive, it will be 

restarted except that it is dead or killed 

normally. 

The anubis working principle is copied 

from the anubis RAD applications: when 

the thread check time is reached, the 

anubis thread will check whether the 

scheduler is alive: if not alive, try to 

restart it. If the scheduler restart times 

reach 5 on the most recent day, the next 

restart time will be delayed to 1 day 

later; If the scheduler restart times reach 

25 in the most recent week, the next 

restart time will be delayed to 2 days 

later. 

To use the new feature, two new 

parameters have been introduced: 

 enableAnubisMonitor: Start the 

Anubis monitor to check the status of 

the background scheduler thread. 

 anubisPollInterval: The time interval 

(in seconds) at which the Anubis 

thread checks to see if any registered 

scheduler is alive. Default is 15 

(seconds).  

Note: When enableAnubisMonitor is 

enabled, the original anubis RAD 

applications should be disabled. 
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QCCR1E72046 Log files report servlet terminations and out-

of-memory errors. A resource is locked and the 

system seems to hang. 

This issue was caused by running 32-bit 

applications on a 64-bit HP-UX system. 

To resolve this issue, the applications 

were recompiled to maintain 

compatibility on 64-bit HP-UX systems. 

QCCR1E72255 When you start scemail (JavaMail) in the 

Windows client, a "Signal 11" message is 

generated. 

This issue was caused by a long message 

being passed incorrectly. A code fix has 

been implemented that prevents the 

"Signal 11" error from being generated. 

QCCR1E73079 Using the RAD fduplicate function on a file 

mapped to attribute tables (MERGE file) 

generates a "Signal 11" if we fail to copy the 

record list. 

The fduplicate function now handles the 

error condition before copying the record 

list. 

QCCR1E73737 The LDAPNOSTRICTLOGIN:1 parameter 

does not have any effect in SM 9.21 when an 

LDAP connection fails. 

Now, when an LDAP connection fails and 

LDAPNOSTRICTLOGIN is set to 1, the 

login will succeed if the login name exists 

in RDBMS. 
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Web client updates  

The following items are fixed in the current software release.  

Global ID Problem Solution 

QCCR1E32210 Users are unable to view an attachment from 

the web client when getAbsolutePath() in 

Attachment.java returns greater than 255 

characters.  

Note: This issue is most likely to occur on 

WebSphere systems, where the deployment 

path to the temp directory is prefixed by 

various WebSphere nodename and server 

names and an attachment file full path is 

dependent on the length of WAR file name and 

the installation path of the application server. 

The web tier now supports long full 

paths (greater than 255 characters) for 

attachments when running on Linux, 

Unix, or Windows with an NTFS file 

system.  

Note: This issue still exists when, in 

rare cases, the web tier is running on 

Windows with a FAT file system.  

 

Note: If the user uses a very long file 

name or folder name, which causes the 

full path of the file to exceed 255 bytes, 

the user will not be able to delete the 

web application server's temporary 

file/folder generated on uploading the 

file (normally under the web application 

server installation directory). Deleting 

the temporary file/folder will fail with a 

system warning message that states the 

file name is too long. In this case, the 

user can do the following to delete the 

file: 

1. Rename the temporary file to a short 

name, and then delete it.  

2. If the delete still fails, open the 

system command prompt, type "dir /x" 

to display the file's short name and then 

run the "rmdir {short name} /S" to delete 

the folder. 

This patch introduces a known issue in 

which the user cannot open an 

attachment on Windows client if the file 

name is longer than 120 characters. 

See QCCR1E73858 in the Known Issues 

section of this document. 

QCCR1E52805 In the Web client, when a data change option 

is specified on a date widget, the corresponding 

display option is not executed when the date is 

changed. 

The display option is now executed 

when the date is changed as expected. 

QCCR1E56885 When opening a record from a record list and 

then clicking a menu item (on the system 

navigator) that launches the 

us.launch.external application, the Web client 

hangs. 

The web client no longer hangs when 

you click the menu item that launches 

the us.launch.external application. 
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Global ID Problem Solution 

QCCR1E58341 Web client users cannot see long descriptions 

in conditional read-only text area fields. The 

scroll bar is inactive, so users cannot scroll 

down or up to read descriptions.  

The scroll bar is now active even when 

the text area is read only, so users can 

scroll to see long descriptions in read-

only text area fields. 

QCCR1E59527 In environments deploying a case-sensitive 

RDBMS in combination with a case-insensitive 

LDAP server for authentication, it might be 

impossible for users to successfully log in to 

Service Manager (SM). 

 

After login, the System Navigator displayed an 

empty tree and the main screen was partially 

rendered, which resulted in an inability to use 

SM. 

If the LDAP is used for authentication, 

users can now successfully log in with a 

lowercase, uppercase, or mixed-case 

user name and use SM properly after 

login. 

 

Without LDAP authentication, the case-

sensitivity of login depends on the case-

sensitivity setting of the RDBMS. 

 

Note: To take advantage of this fix, 

users must also update their server to 

SM 9.21.p5 or later. 

QCCR1E61175 Users are unable to add activities because the 

buttons become unusable after selecting the 

update type in the list of activities. The reason 

is that the detail window is not loaded 

properly. 

Now when users click the Activities tab 

(or expand the Activities section) and 

select an update type, the buttons are 

available for use and working properly. 

QCCR1E61880 After updating a few other fields of a problem 

ticket, the user received the following error 

message when updating the Affected CIs field 

using Fill: "Cannot find related information in 

device using query: true and 

logical.name#"Work In Progress"'. 

Reset the focus field so that when the 

focus is moved, the Web Tier will send 

the correct field to the background and 

fetch the correct records. The error no 

longer occurs. 

QCCR1E62049 When deploying the web tier, an XSLT 

compilation error is displayed in the sm.log for 

<webtier>\WEB-

INF\templates\topaz\datetime.xsl. 

The XSL file has been formatted 

correctly, so the compilation error no 

longer occurs. 

QCCR1E62168 If a user has an LW-SSO cookie but the user is 

not created in Service Manager, there is a loop 

in the application. 

Web client displays an error page if a 

user has an LW-SSO cookie but the user 

is not created in Service Manager. 

QCCR1E62821 Using the ALT+CTRL+C key command in the 

Web client to start spell check does not work 

when using the OS's Polish language pack. 

Instead, an HTML error page is displayed. 

Now, if the specified language 

dictionary cannot be found in Service 

Manager, a default dictionary will be 

used, which prevents the error page 

from being displayed. 

QCCR1E63661 Keyboard shortcuts in the accessible web client 

were not working for the Save display option 

button. 

For the Save option, keyboard shortcuts 

in Service Manager 9.21 P5 and later 

have been changed to Ctrl+Shift+F4. 

QCCR1E64226 A misused Service Manager keyboard event The code has been fixed so that the 
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handler prevents the browser toolbar from 

being freed. This behavior causes a memory 

leak. 

Service Manager keyboard event 

handler is released properly from the 

toolbar. 

QCCR1E65001 Users are not able to do simple things like 

approve a change request due to the following 

error: "Field contains an invalid numeric value 

(display,show.rio)" 

Revised the handling of read-only 

comfill widgets so the proper value will 

be posted to the server. 

QCCR1E66683 It is not possible to select a catalog line item by 

clicking on the group value when the group 

value is missing. 

Empty columns are rendered properly in 

the table so users can select rows by 

clicking on an empty column. 

QCCR1E66961 The wrong incident is displayed after selecting 

it from the ToDo queue. 

The correct record is displayed after it is 

selected from the ToDo queue and 

refreshed. 

QCCR1E67011 Users lose unsaved ticket information after 

closing a QBE list within another thread. 

Corrected a tab update issue where it 

was using the wrong url after displaying 

a hover form. 

QCCR1E67134 When a Format Control validation fails on a 

field that is inside a collapsed group, the focus 

does not jump to that field. 

A group that contains a focused field is 

automatically expanded to show this 

field. 

QCCR1E67196 When users add an attachment to a ticket with 

the "Specify File Location" field empty and 

then click OK, they receive a logged-out 

message in the Attachment window. If they 

attempt to continue to work in the session, a 

log-in screen appears. 

Note: The Web Tier was deployed on 

WebSphere 7.0. 

When users attempt to add an 

attachment to a ticket with the "Specify 

File Location" field empty, the "OK" 

button is disabled, unless they select an 

existing file from the file chooser. 

QCCR1E67900 Users receive the following error message 

when opening a view on the web client if the 

view uses a "CONTAINS" comparison operator 

in the AutoFormat rules. 

 

"Message: Syntax error 

Line: 3752 

Char: 111 

Code: 0 

URI: 

http://<hostname>/client/gwt/com.hp.ov.sm.clie

nt.webtier.gwt.list.SmList/984A08B996FB3EA

2340381B694BDF8BA.cache.html" 

The regular expression for comparing 

and replacing the CONTAINS and NOT 

CONTAINS has been corrected so that 

this error does not occur. 
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Global ID Problem Solution 

QCCR1E68704 The hover form in Service Manager 9.21 P3 

HF2 caused serious browser lockups and 

issues when it was used on an array field. 

Symptoms included delays in the pop-up being 

displayed, accompanied by an audible clicking 

noise. 

The pop-up displays in a timely manner 

without an audible clicking noise. 

QCCR1E69005 Selecting a record in a recordlist caused the 

whole recordlist to refresh, which caused a 

performance issue. 

When a record is selected in a recordlist, 

the recordlist is not automatically 

refreshed. 

QCCR1E68989 On a form that contains Dynamic View 

Dependency (DVD) conditions, the dependency 

result is incorrect after the user clicks 

"Validate Format" or presses Enter. 

The dependency result is now correct. 

QCCR1E69216 The web browser hangs after navigating 

between queues. Often users will get the 

following message: "Internet Explorer Cannot 

display the web page." Users need to delete 

temporary files and cookies, and then restart 

Internet Explorer to get to a log-in page. 

The web client no longer produces errors 

or hangs when users navigate between 

queues. 

QCCR1E69316 In Trusted Sign-On (TSO) mode, when a user 

pressed F5 on the browser multiple times 

during initial communications between the 

client and server, multiple server sessions 

were established. 

In TSO mode, when the user launches 

the web client in a browser, a login 

progress screen displays, which 

instructs the user to wait and not to 

refresh the screen. Even if the user 

ignores this warning and presses F5 or 

the refresh button on the browser, 

Service Manager will not establish new 

sessions for the user. 

QCCR1E69299 A java.lang.RuntimeException occurs when 

processing dynamic form data. 

No java.lang.RuntimeException occurs 

when processing dynamic form data. 

QCCR1E69488 Multiple users are simultaneously 

disconnected from the Service Manager (SM) 

web client, and then directed to the "login 

again" page (session timeout). This creates 

multiple sessions, which are seen connecting 

back to SM although users have not logged in 

but instead left the browser on the "login 

again" screen. 

Multiple sessions are no longer created 

for clients when there are log-in 

problems. 

QCCR1E69476 In the web client, in the Approval Log section 

of Change Management, the comments column 

does not display input values after the first 

row. 

The comments column displays input 

values after the first row in the 

Approval Log section. 

QCCR1E69692 The major Service Manager CSS and 

JavaScript resources do not expire if the 

The locations of the major CSS and 

JavaScript resources are changed to a 
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customer upgrades the Web tier without 

changing the context path. 

path that reflects the current build 

number. Therefore, the client's browser 

does not make use of the CSS and 

JavaScript cache from an old version. 

See the “Changes to the Web Tier 

Directory Structure” section of this 

document.  

QCCR1E69868 On a search screen, if the user adds a Comfill 

whose value is "masked" using a value-display 

list and then selects a value and searches on it, 

no results are returned.  

The correct data (the value list value) is 

now sent to the server so that the 

correct records are returned. 

QCCR1E69969 The Service Manager Tomcat instance has a 

large and increasing number of HTTP 

connections. Java monitoring data indicates 

that Service Manager creates over 500 HTTP 

connections. The Service Manager Web Tier 

thread dumps indicate that numerous threads 

are in a state of BLOCKED while waiting to 

acquire a monitor lock. 

Concurrency handling has been 

improved to avoid numerous threads 

being blocked during long-running 

queries. 

- Times out the socket reading operation 

in a timely manner to avoid a thread 

being infinitely blocked by the socket IO 

operation. Added a parameter named 

socketReadTimeout to specify the 

timeout when reading from the socket; 

the default value is 180s. 

- Times out the lock acquiring in a 

timely manner to avoid a thread 

infinitely waiting for the lock. Added a 

parameter named lockWaitTimeout to 

specify the maximum time to wait for 

the lock; the default is 15s. 

- Does not acquire the lock for the 

heartbeat request 

(service.do?name=getMessages) as it 

does not communicate with the SM 

server, but only fetches the messages 

from the message store on which the 

accessing is already synchronized. 

See the “New Mask and Timeout 

Parameters” section of this document. 

QCCR1E69952 A Java exception occurs when printing in 

Service Manager. 

No Java exception occurs when printing 

in Service Manager. 



 29 

Global ID Problem Solution 

QCCR1E70298 When the user opens a recordlist in the web 

client, the recordlist is not displayed and the 

web client hangs. This issue occurs when the 

user switches the tab page before the current 

tab page finishes its rendering. Starting from 

Service Manager 9.2, CWC5 assumes that user 

does not switch tab pages when the current 

page is still loading. 

The mask feature has been improved so 

that the mask persists long enough in a 

user transaction to prevent user 

operation before the current page 

finishes its rendering. 

 

 

 

 

- 

QCCR1E70511 A java.util.ConcurrentModificationException 

occurs when users use the HTML Viewer. This 

issue could occur when multiple clients are 

accessing the same HTML Viewer object 

simultaneously. 

No ConcurrentModificationException 

occurs when users use the HTML 

Viewer. 

QCCR1E71070 After a failed attempt of an employee self-

service (ESS) user to access Service Manager, 

the client session still remains for that user. 

This issue occurs in an LWSSO-enabled 

environment. 

The web client now terminates the 

session before forwarding the request to 

the authFailure.jsp page. 

QCCR1E71294 SOAP messages are not logged even though 

you set the tracesoap parameter to true. 

Soap message are now logged as 

expected if the user sets the tracesoap 

parameter to true. 

QCCR1E71381 On the Web client, when an operator accesses 

a change ticket with partial approval, and then 

clicks Save without making any changes to the 

ticket, the Reset Approvals form is displayed. 

This form indicates that a change has been 

made to the ticket even though no change has 

been made. 

When editing contents with multiple 

lines in a textarea component with a 

visible/invisible DVD condition, no extra 

blank lines will be inserted in the 

contents after saving the record. 

QCCR1E71734 The copyright date on the splash screen and 

the about page needs to be updated to the 

current year. 

Copyright date in splash screen and 

about pages are updated to the current 

year. 

QCCR1E72029 Using Internet Explorer 8, the web client 

intermittently hangs when performing actions 

like cancelling a Service Desk interaction or 

performing a Fill operation. 

When a JavaScript error is detected and 

the window mask is displayed for 15 

seconds, a red close button to the left of 

the logout button will appear. Clicking 

this button will close the window mask 

and prevent the browser from hanging. 

QCCR1E72392 The incorrect ESS starting page is displayed if 

the user has previously attempted to log in 

with the incorrect account details. 

The correct ESS starting page is 

displayed even if the user has 

previously attempted to log in with the 

incorrect account details. 

QCCR1E72650 A selected Incident record is not highlighted on The selected Incident is still highlighted 
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Global ID Problem Solution 

the QBE list after changing the Closure Code. on the QBE list after the Closure Code. 

QCCR1E72764 When creating a new Incident and then 

canceling the Incident, the user sees a blank 

page. 

Now, the user sees a refreshed page as 

expected. 

QCCR1E73037 The original minimum value of 

unmaskDeferMillis parameter is 750 

milliseconds. This does not allow for a lot of 

space for users to tune this value. 

Service Manager now allows the 

unmaskDeferMillis parameter value to 

be set to a lower minimum value of 350 

milliseconds. 

Note: The default value is changed from 

1000 milliseconds to 750 milliseconds. 

Users should be very cautious when 

setting this paramter to a lower value. 

The Web client will log a warn message 

when setting it to a value less than 550 

milliseconds. 

QCCR1E73617 Leaving the Web client by pressing ALT+TAB 

causes the page to reload. 

Leaving the Web client by pressing 

ALT+TAB no longer causes the page to 

reload. 

Windows Client Updates   

The following item (identified by reference number) is fixed in the current software release.  

Global ID Problem  Solution  

QCCR1E57474 Dynamic view dependency (DVD) does not 

work when the source is on a tab that comes 

after an invisible tab in a notebook. 

DVD conditions now work properly on a 

notebook tab that comes after an invisible 

tab. 

QCCR1E65372 When the user went into the Knowledge 

Base search form and de-selected the 

Incident_Library check box, all the other 

options also disappeared. 

When the user goes into the Knowledge 

Base search form and de-selects the 

Incident_Library check box, the other 

options will remain. 

QCCR1E65709 The focus is returned to the beginning of the 

form when tabbing through a comfill widget 

with the data changed event set. 

If the Tab key is pressed on a combo box, it 

will no longer fire a Data Change Event. 

Therefore, the focus of the form will not 

change. 

QCCR1E66750 You cannot print a record using the 

"File>Print" option in the Windows client if 

the record has an attachment. 

You can use the "File>Print" option in the 

Windows client to print a record. 

QCCR1E69500 When a table object is added to a format by 

using Forms Designer to retrieve/add/update 

data and one of the columns or fields is a 

datetime datatype, users expect to be able to 

select a date using the visual calendar 

This issue occurs because of differing data 

types. Now, this data type has been 

converted so that the dateTime control can 

be created correctly. 
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Global ID Problem  Solution  

widget. This does not work in the Windows 

client, but works correctly in the Web client. 

QCCR1E72633 A Script error prompt is received when user 

tries to execute a print job in the Service 

Manager Windows client. Regardless of the 

users action at the prompt, nothing is 

printed. 

The user now can print properly in the 

Service Manager Windows client. 
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 Known Problems, Limitations, and Workarounds 

This software release has the following known issues. 

Global ID  Known Issue  Workaround  

QCCR1E66663 As of SM9.20 the plug-in technology that 

allowed 3rd parties to directly access the 

SM server to create their own SM clients 

has been deprecated.  

However, all the documentation on how to 

use and implement a plug-in still exists in 

the online help server confusing customers 

and implementers on whether plug-ins are 

still to be used or not. 

Use Web services to enable all interfaces in 

and from SM. 

The documentation has been updated for 

the latest release of Service Manager.  

However, for older versions of Service 

Manager, the documentation cannot be 

updated. 

QCCR1E69449 When a user tries to update a DBDICT for 

an Incident, they receive the following 

"Signal 11" error: 

  

RTE E Caught XML API exception 

scxmlapi(40).  

 

This issue occurs when another user is 

updating the probsummary dbdict record at 

the same time. 

To work around this issue, make sure that 

no other users are updating existing records 

or inserting new records in DBDICT at the 

same time.  

Note: This workaround will be included in 

the "Database dictionary (DBDICT) utility" 

section of the Tailoring Best Practices Guide 

of the next release of Service Manager. 

 

QCCR1E71543 Customer-developed RAD applications 

hangs with a "Signal 11" error. This issue 

occurs even after applying a previous hotfix 

meant to fix this issue. 

If your JavaScript files are very large 

(>340k lines), try setting 

the "jsgctrigger" parameter from the default 

(8 MB) to 80 MB. 
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Global ID  Known Issue  Workaround  

QCCR1E57385 When Service Manager is running on Unix, 

the legacy listener may log intermittent 

signal 11 upon CIT initial connectivity test 

if exec-shield is not set properly. 

Two workarounds are available.  Use one of 

the following solutions to solve this issue on 

Unix. 

 

Solution 1: 

Connect Connect-It to the Web Services 

connector instead of the Legacy Listener 

connector. 

 

Solution 2: 

Before connecting Connect-It to the Legacy 

Listener connector, do the following: 

1. Add  usethreading:0 in the sc.ini file, 

which is located in the following location: 

 

<Service Manager server installation 

path>\LegacyIntegration\RUN. 

 

Note: For 64-bit RedHat Linux servers only, 

you can alternatively run the following shell 

commands as root: 

             # sysctl -w kernel.exec-shield=0 

             # sysctl -w 

kernel.randomize_va_space=0 

 

2. Start the legacy listener. 

QCCR1E73858 The SM9.30.201 build (Patch 3) Windows 

client cannot open attachments that have a 

long filename (120 characters). 

There is no workaround at this time. 
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Installation Notes 

Digital signature notice 

HP signs Windows executable files with a digital signature. This process has been updated to use a new 

VeriSign root certificate. On a Windows system that does not have the new VeriSign root or intermediate 

certificate installed, when the user right-clicks the file and then goes to Properties > Digital Signatures > 

Details, a verification error will display: “The certificate in this signature cannot be verified.”   

 

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as 

documented at: https://knowledge.verisign.com/support/ssl-certificates-

support/index?page=content&actp=CROSSLINK&id=SO19140 

Web Tier installation 

Important Note:  The Service Manager 9.21 Patch 5 release introduces important changes to the Web tier 

Directory structure.  For more information on these changes, see the “Changes to the Web Tier Directory 

Structure” section this document and the “Updates to the Service Manager Web Tier Directory 

Structure” white paper at the HP Software support Web site: 

www.hp.com/go/hpsoftwaresupport 

https://knowledge.verisign.com/support/ssl-certificates-support/index?page=content&actp=CROSSLINK&id=SO19140
https://knowledge.verisign.com/support/ssl-certificates-support/index?page=content&actp=CROSSLINK&id=SO19140
http://www.hp.com/go/hpsoftwaresupport
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The Web Tier update consists of a compressed file, sm9.21.290-P5_Web_Tier.zip. The specific upgrade 

process depends on your particular Web application server, but follows the same steps as deploying a new 

installation. For more information, refer to the Service Manager Installation Guide. 

The upgrade does not automatically save your Web Tier customizations. To keep your changes, you must 

save your customized files and replace the new version of these files with your customized version. 

To install the Web Tier update: 

1 Back up your web.xml file, splash screen, style sheets, and any other customizations you made, including 

your webtier-9.21.war (.ear) file. 

2 Delete or uninstall the existing webtier-9.21.war (.ear) file. 

3 Deploy the new webtier-9.21.war (.ear) file by following the instructions in the Service Manager 

Installation Guide. 

4 Replace the new versions of any files you customized with your customized versions. 

5 Make any new customizations necessary for your deployment. 

Note: Be sure to set the securelogin and sslport parameters. 

6 Restart the Application server. 

Windows Client Installation 

The Windows client update consists of a compressed file, sm9.21.290-P5_Win_Client.zip, which 

contains setup.exe. 

To install the Windows client update: 

1 Stop the Service Manager Windows client. 

2 Uninstall the Service Manager Windows client. (Your connection and personalized settings are retained.) 

3 Run setup.exe and install the client by following the instructions in the Service Manager Installation 

guide and Release Notes for your version. 

4 Check the version in Help > About Service Manager Client.  

The client should be Release: 9.21.290. 

Server Installation 

The server update for your operating system (OS) consists of a compressed file, sm9.21.290-P5_<OS>.zip  

(or .tar), which contains the Service Manager server files. These files add to or replace the files in the [SM 

Root]\ ([SM Root]/) RUN, irlang, legacyintegration, and platform_unloads directories. 

To install the Server update: 

1 Stop all Service Manager clients. 

2 Stop the Service Manager server. 

3 Make a backup of the RUN directory. 

4 Extract the compressed files for your operating system into the main Service Manager directory on the 

server. The default path is:  C:\Program Files\HP\Service Manager 9.21. 
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5 For UNIX servers, set the file permissions for all Service Manager files to 755. 

6 Remove the following files from the "\RUN\lib" directory:  

 saaj-impl-2.1.jar 

 saaj-api-2.1.jar 

 jgroups-all-2.5.0.jar 

7 Remove the following files from the "\RUN\lib\endorsed" directory:  

 xercesImpl-jaxp-1.3.2.jar 

 xalan-jaxp-1.3.2.jar 

 jaxp-api-1.3.2.jar 

 dom-jaxp-1.3.2.jar 

 sax-jaxp-1.3.2.jar 

8 Restart the Service Manager server. 

9 Restart the Service Manager clients. 

10 Check the version in Help > About Service Manager Server.  

The server should be Release: 9.21.290. 

Application Unload Installation 

The application consists of the unload files that come with the server updates. When you extract 

sm9.21.290-P5_<OS>.zip (or .tar), it will add the new files to your  

[SM Root]\platform_unloads ([SM Root]/platform_unloads) directory. 

Unload File Naming Convention 

The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where: 

 <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, 

QCCR1E12345. Note that this is always the number of the parent CR of a CR family (if any). 

 SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, 

SM921P2, which means the unload file comes with the server updates in Service Manager 9.21 patch 2 

and should be used for patch 2 or higher.  

Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This 

example means the unload file is intended for Service Manager 7.11 patch 16 Hot Fix 8 or higher.  

 SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, 

which means the unload file is intended only for Service Manager applications version 7.11. 

Note: If this suffix is omitted, the unload file is then intended for all applications versions compatible 

with the server version. For example, for Service Manager server 9.21, the compatible applications 

versions are 7.11 and 9.20. 
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New Application Updates in the Current Patch 

There are following new application updates are included in this release: 

Unload file Used for applications 

version(s) 

Description  

QCCR1E67647_SM921P5.unl 7.11 and 9.20 Updated the scmessage record from 

"Doc Engine call failed” to include 

the message number.  

 

QCCR1E70163_SM921P5_SM711.unl 7.11 Prevents the KMUpdate process from 

terminating when the Search Engine 

server is shut down or an indexing 

document error occurs. 

 

QCCR1E70163_SM921P5_SM920.unl 9.20 Prevents the KMUpdate process from 

terminating when the Search Engine 

server is shut down or an indexing 

document error occurs. 

 

Application Updates in Previous Patches 

Important Note:  The unload files must be loaded in order of patch.  That is, all Patch 1 unload files must 

be loaded before any Patch 2 unload file is loaded and so on for Patch 3, Patch 4 etc...  However, the order in 

which you load the unload files for Patch 1 does not matter. 

Additional application updates have been included with this cumulative release. If you have not already 

applied them for a previous patch, you should also apply the unload files that are used for your applications 

version (see the following table). For more details about these applications updates, see the Release Notes for 

those patches, also included with the release. 

Unload file Introduced 

in 9.21 patch 

Used for 

applications 

version(s) 

Description  

QCCR1E55715_SM921p1.unl 

 

P1 7.11 and 9.20 Includes application changes to 

reduce database I/O on login. 

 

 

QCCR1E57767_SM921p1.unl P1 7.11 and 9.20 Includes application changes to 

reduce jgroups traffic on login. 

 

 

QCCR1E59753_SM921p2.unl P2 7.11 and 9.20 Includes application changes to 

fix the ToDo bar.  

 

 

QCCR1E31545_SM921P2_SM711.unl P2 7.11 Prevents backslashes included 

in a template from being 

duplicated in the output. 

Note:  This file is not required 

for Applications 7.00. 
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Unload file Introduced 

in 9.21 patch 

Used for 

applications 

version(s) 

Description  

QCCR1E31545_SM921P2_SM920.unl P2 9.20 Prevents backslashes included 

in a template from being 

duplicated in the output. 

 

QCCR1E49721_SM921P3_SM711.unl P3 7.11 Enables translation of 

Display/Value lists on dynamic 

forms. This is a required fix for 

the Export to Excel redesign. 

 

QCCR1E56678_SM921P3_SM711.unl P3 7.11 Lists the records in the right 

group order when a record list 

is refreshed. 

 

QCCR1E58562_SM921P3_SM711.unl P3 7.11 Includes applications changes 

for Export to Excel redesign. 

 

QCCR1E58562_SM921P3_SM920.unl P3 9.20 Includes applications changes 

for Export to Excel redesign. 

 

QCCR1E67610_SM921P4.unl P4 7.11 and 9.20 Enables you to block 

potentially dangerous 

attachments. 

 

QCCR1E67072_SM921P4.unl P4 7.11 and 9.20 Enables you to improve the 

Knowledge Management 

update process (KMUpdate) 

performance. 

 

To load an unload file: 

1 Make sure the Windows client is configured for server-side load/unload.  

a) From the Windows client, go to Window > Preference > HP Service Manager.  

b) Unselect Client Side Load/Unload if is flagged.  

c) Restart the Windows client. 

2 Open Tailoring > Database Manager. 

3 Right-click the form or open the options menu and select Import/Load. 

4 Fill in the following fields. 

Field Description 

File Name Type the name and path of the file to load. 

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 

blank. 

File Type Select the source operating system of the unload file. 

Messages Option —  

All Messages 

Select this option to see all messages that Service Manager generates loading the 

file. 

Messages Option —  

Totals Only 

Select this option to see only the total number of files Service Manager loads. 
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Field Description 

Messages Option — 

None 

Select this option to hide all messages that Service Manager generates when 

loading the file. 

Note: You can view the contents of an unload file before importing it by clicking List Contents. 

5 Click Load FG.  
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Verified Environments 

The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software products, 

and other compatibility and support information.  

To access the Compatibility Matrix:  

1 Use a browser to navigate to the Software Support Online (SSO) web page:  

http://support.openview.hp.com/sc/support_matrices.jsp 

2 Log on with your Customer ID and password or your HP Passport sign-in.  

3 Navigate to the applicable information.  

Local Language Support 

UTF-8 is part of the Unicode standard, which enables you to encode text in practically any script and 

language. Service Manager 9.21 supports UTF-8 as an encoding method for new or existing data. It can 

support multiple languages that adhere to the Unicode standard on the same server. 

Support 

You can visit the HP Software support web site at: 

www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 

Software offers.  

HP Software online software support provides customer self-solve capabilities. It provides a fast and efficient 

way to access interactive technical support tools needed to manage your business. As a valued support 

customer, you can benefit by using the support site to: 

 Search for knowledge documents of interest 

 Submit and track support cases and enhancement requests 

 Download software patches 

 Manage support contracts 

 Look up HP support contacts 

 Review information about available services 

 Enter into discussions with other software customers 

 Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 

an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html 

http://support.openview.hp.com/sc/support_matrices.jsp
file:///C:/Users/rooks/Documents/www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 

accompanying such products and services. Nothing herein should be construed as constituting an additional 

warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 

with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 

Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 

commercial license. 

Copyright Notice 

© Copyright 1994-2012 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

 Adobe™ is a trademark of Adobe Systems Incorporated. 

 Java™ is a registered trademark of Oracle and/or its affiliates. 

 Microsoft
®
 and Windows

® 
are U.S. registered trademarks of Microsoft Corporation. 

 Oracle
®
 is a registered US trademark of Oracle Corporation, Redwood City, California. 

 UNIX
®
 is a registered trademark of The Open Group. 

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online 

web site and search for the product manual called HP Service Manager Open Source and Third Party 

License Agreements. 

 


